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Overview

Overview

The Cobra 8.3 Cumulative Update 01 release includes all of the enhancements, software issues resolved,
and database changes that were made in Cobra 8.3 CU 01.

Custom Programs Affected

Sometimes an update can cause custom programs and reports to stop working as expected. Before
applying this update, consider whether you have any custom programs or reports in the application area
affected by the update. If so, contact Deltek Customer Care at http://support.deltek.com before you install
the update.

Attention: For steps to install the cumulative update, see Appendix A: Download and Install the
Cumulative Update.

Viewing the Online Help

If you use Internet Explorer and the online help does not display correctly, you need to turn off
Compatibility View for the browser. Click Tools » Compatibility View settings, and clear the Display
intranet sites in Compatibility View check box. Then refresh the browser. Make sure you remove
deltek.com (if listed) from the Websites you have added to Compatibility View list. You could also elect
to use hosted help or the FQDN of your server in the URL (for example, server.domain) to bypass this
issue. Depending on your Internet Explorer security settings, you may be prompted to “Allow blocked
content” when viewing the online help locally. The Cobra 8.3 Help System URL is
https://help.deltek.com/Product/Cobra/8.3/GA.

Depending on your Internet Explorer security settings, you may be prompted to “Allow blocked content”
when viewing the Cobra Online Help locally. This only affects Internet Explorer.

You may also access the online help using Chrome and Firefox.
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Cobra 8.3 Cumulative Update 01

Released: January 31, 2020

Enhancements

There are no enhancements in this release.

Software Issues Resolved

File » Integration Cost Data Export
Defect 1237415

Description: When you ran the Cost Data wizard against a large project to generate the Deltek Costa
Data Exchange (DCDE) file, Cobra would crash with a "System.OutofMemoryException" error.

Customers Impacted: This defect affects all users.
Workaround Before Fix: None.
Additional Notes: None.
Files Updated:
= Cobra.WinUlL.*.dll
=  Cobra.WinUl.exe
= Cobra.Model.dll
= Cobra.Model.LoginManager.dl|
= PPM.CostData.dll

File » Integration Wizard — Project Data
Defect 1194236

Description: When you initialized a shared database between Open Plan 8.3 and Cobra 8.3 using the
Open Plan 8.3 Data Tool, the following error occurred: “Unable to insert data into target table WST_UPF."

Customers Impacted: This defect affects users who use Cobra 8.3 with Open Plan 8.3 on an Oracle or a
SQL database.

Workaround Before Fix: None.

Additional Notes: This defect is tracked in Deltek Open Plan 8.3 Cumulative Update # 04 Defect
1222654.

Files Updated:
=  OpenPlanDataTool.exe
= SQL\Access\OPMaster82.mdb
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Defect 1225665

Description: When you initialized a shared database between Open Plan 8.2 and Cobra 8.3 using the
Open Plan 8.2 Data Tool, the following error occurred: “Unable to insert data into target table WST_UPF."

Customers Impacted: This defect affects users who use Cobra 8.3 with Open Plan 8.2 on an Oracle or a
SQL database.

Workaround Before Fix: None.

Additional Notes: This defect is tracked in Deltek Open Plan 8.2 Cumulative Update # 13 Defect
1225706.

Files Updated:
=  OpenPlanDataTool.exe
=  SQL\Access\OPMaster82.mdb

Defect 1225668

Description: When you initialized a shared database between Open Plan 8.3 and Cobra 8.3 using the
Open Plan 8.3 Data Tool, the following error occurred: “Unable to insert data into target table WST_DCT."

Customers Impacted: This defect affects users who use Cobra 8.3 with Open Plan 8.3 on a SQL
database.

Workaround Before Fix: Re-initialize the Open Plan Data Tool.

Additional Notes: This defect is tracked in Deltek Open Plan 8.3 Cumulative Update # 04 Defect
1222654.

Files Updated:
=  OpenPlanDataTool.exe
=  SQL\Access\OPMaster82.mdb

Defect 1225670

Description: When you initialized a shared database between Open Plan 8.2 and Cobra 8.3 using the
Open Plan 8.2 Data Tool, the following error occurred: "Unable to insert data into target table WST_DCT."

Customers Impacted: This defect affects users who use Cobra 8.3 with Open Plan 8.2 on a SQL
database.

Workaround Before Fix: Re-initialize the Open Plan Data Tool.

Additional Notes: This defect is tracked in Deltek Open Plan 8.2 Cumulative Update # 13 Defect
1225706.

Files Updated:
= OpenPlanDataTool.exe
= SQL\Access\OPMaster82.mdb

Help
Defect 1237371
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Description: When you accessed the Cobra Help locally, opened the Data Dictionary topic, and clicked
the Data Dictionary link, you would encounter the following error: "Cannot find file... Make sure the path or
internet address is correct."

Customers Impacted: This defect affects all users.
Workaround Before Fix: Access the Data Dictionary using the hosted help.
URL: https://help.deltek.com/Product/Cobra/8.3/GA/DataDictionary/index.htm
Additional Notes: None.
Files Updated:

= DeltekCobra83.exe

Projects » Project View
Defect 1179645

Description: When you modified a control account in the project view and then moved to another control
account, Cobra would not save the changes automatically if the project audit log was turned on and the
log level was set to work package or resource assignment.

Customers Impacted: This defect affects all users.
Workaround Before Fix: None.

Additional Notes: Cobra should save the changes automatically after you modify a control account and
move to another one whether the audit log is enabled or disabled at any level.

Files Updated:
= Cobra.WinUL.*.dll
= Cobra.WinUl.exe

Projects » Calculate Forecast
Defect 1225384

Description: When you ran the Calculate Forecast wizard against a forecast class that did not exist as a
resource assignment, Cobra would create the forecast time-phased data but would not create the
resource assignment if any of the following conditions applied:

= The class was the last forecast class processed for each control account or work package.
= Closed control account or work packages
= ETC value was 0.

=  Forecast method was Manual Forecast (Retain EAC), actual total was not 0, and existing BAC
was 0.

Customers Impacted: This defect affects all users.
Workaround Before Fix: None.
Additional Notes: None.
Files Updated:
= Cobra.WinUl.*.dll
= Cobra.WinUl.exe

Cumulative Update 01 Release Notes 4


https://help.deltek.com/Product/Cobra/8.3/GA/DataDictionary/index.htm

Deltek

Cobra 8.3 Cumulative Update 01

=  Cobra.Process.dll

Defect 1238441

Description: When you ran the Calculate Forecast wizard against a forecast class that used the Percent
Complete Ranges forecast method and more than one control account or work package were being
calculated, Cobra would calculate the forecast using the PF=1 method if any of the following conditions
applied:

= The performance factor level was set to control account or work package and the length of the
CA/WP ID was longer than the ID of the first control account or work package processed.

=  The control account or work package percent complete did not match the % complete range of
the first control account or work package processed.

Customers Impacted: This defect affects all users.
Workaround Before Fix: None.
Additional Notes: None.
Files Updated:
= Cobra.WinUl.exe

= Cobra.Process.dll

Defect 1237351

Description: When you ran the Calculate Forecast wizard, Cobra would fail with the "String ID
ID_ COB_PRC_CFCST_MSG88 does not exist" error.

Customers Impacted: This defect affects all users.
Workaround Before Fix: None:
Additional Notes: None.
Files Updated:
= Cobra.WinUl.*.dll
= Cobra.WinUl.exe

=  Cobra.Process.dll

Project Processes » Calculate Progress
Defect 1228656

Description: When you ran the Calculate Progress wizard and set the Progress by option on the
Options page to Budget, the total progress value would exceed the total budget for resuli(s) if the
budgeted result(s) contained significant negative values and/or rate reduction.

Customers Impacted: This defect affects all users.
Workaround Before Fix: None.

Additional Notes: Calculated earned value will be adjusted so that by result, its earned value does not
exceed the BAC. For each result, Calculate Progress will total the calculated earned value and subtract
that from BAC.
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= If the calculated earned value is greater than BAC, Calculate Progress will set earned value to
equal BAC.

Exception: If the calculated earned value and BAC are both negative, Calculate Progress will
use the positive value of both values to compare if Calculated Earned > BAC.

= This will only affect Progress by method = “Budget”. The behavior for all of the other Progress
by methods (Dollars, Hours SPI, and Time) will not change.

= This will be applied to all Progress techniques except for Level of Effort, as LoE should always
equal budget month by month.

With exception to LOE, the following example scenarios show how Calculate Progress will now calculate
when a result’s earned value exceeds its BAC:

BAC 400 360 -400 -360 400 -400 -1 -400

Previously = 360 400 -360 -400 -360 360 -400 1
Calculated
Earned

New 360 360 -360 -360 -360 -400 -1 -400
Calculated
Earned

Files Updated:
=  Cobra.WinUL*.dll
= Cobra.WinUl.exe

= Cobra.Process.dll

Database Changes

This section includes changes made to the database. There are no database changes in this release.

Data Changes

This section includes changes to the data applied by script. There are no data changes in this release.

Documentation Changes

This section includes details of section changes in the printed documentation. There are no
documentation changes in this release.
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Appendix A: Download and Install the
Cumulative Update

Download the Cumulative Update

From Internet Explorer, go to https://dsm.deltek.com.

Click Run Deltek Software Manager.
Log in using your Deltek Customer Care Connect credentials.
In the left pane of the Deltek Software Manager, expand your Deltek product.

Expand the Cumulative Updates folder for your product, and select the update to download.

2

Click Download at the bottom of the screen.

Install the Cumulative Update

Use the instructions below that apply to the Cobra version you use.

Note: You must install the entire update package. If an update addresses more than one defect, you
cannot fix one defect at a time.

For Cobra 8.x and Higher

The instructions for installing an update for Cobra 8.x and higher depend on your type of deployment. Use
the instructions below that apply to your deployment scenario.

Note: You must install the entire update package. If an update addresses more than one defect, you
cannot fix one defect at a time.

If You Use a Deployment Server

To install on the server:
1. Verify that Cobra is not running.

2. Launch the update on the server.

close Cobra. Choose Yes to start the installation or choose No to cancel the installation.

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to

3. The Welcome screen displays the current build, along with the new build being installed by the
update. Click Next to begin the installation.

The installation wizard installs all necessary files and displays the Update Complete form.
Click Finish.
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6. Depending on the type of update, a reboot may be required. If the option to reboot your computer
is enabled, select it and click Finish.

7. Launch the Deltek Cobra shortcut on client workstations to initiate the update.

To install on a client workstation:

1. Launch the Deltek Cobra shortcut. Cobra detects that an updated version is available and
displays the prompt: Do you want to install the upgrade?

2. Choose Yes to start the installation or choose No to cancel the installation. When the installation
is completed, the installation wizard closes.

3. Launch the Deltek Cobra shortcut to log into Cobra.

If You Have an N-Tier Deployment

To install on the server:
1. Verify that Cobra is not running.

2. Launch the update on the server.

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to
close Cobra. Choose Yes to start the installation or choose No to cancel the installation.

3. The Welcome screen displays the current build, along with the new build being installed by the
update. Click Next to begin the installation.

The installation wizard installs all necessary files and displays the Update Complete form.
Click Finish.

Depending on the type of update, a reboot may be required. If the option to reboot your computer
is enabled, select it and click Finish.

7. Launch the Deltek Cobra shortcut on n-tier client workstations to initiate the update.

To install on an n-tier client workstation:

1. Launch the Deltek Cobra shortcut. Cobra detects that an updated version is available and
displays the prompt: Do you want to install the upgrade?

2. Choose Yes to start the installation or choose No to cancel the installation. If you choose Yes,
the installation wizard copies the updated DeltekCobraWorkstation.exe file locally and
automatically begins installing files. When the installation is completed, the installation wizard
closes.

3. Launch the Deltek Cobra shortcut to log into Cobra.

If You Have a Terminal Services/Citrix Deployment

To install on the deployment server:
1. Verify that Cobra is not running.

2. Launch the update on the server.
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7.

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to
close Cobra. Choose Yes to start the installation or choose No to cancel the installation.

The Welcome screen displays the current build, along with the new build being installed by the
update. Click Next to begin the installation.

The installation wizard installs all necessary files and displays the Update Complete form.
Click Finish.

Depending on the type of update, a reboot may be required. If the option to reboot your computer
is enabled, select it and click Finish.

Log on as a Local Administrator on the Terminal Server/Application Server and install the update.

To install on the Terminal Server/ Application Server (the server on which the Cobra client runs):

1.

Log on to the Terminal Server using an account that has Local Administrator privileges. When the
setup launches, the installation program installs all necessary files and any registry updates and
makes these changes available to all users who will subsequently log on to the Terminal Server
session to run Cobra.

Ensure that no instance of Cobra is running.

Browse to the shared Cobra Workstation folder (usually located on the deployment server, as
\\{DeploymentServerName}\CobraWorkstation\DeltekCobraWorkstation.exe).

Launch the DeltekCobraWorkstation.exe file to install the update. The Welcome screen displays,
showing that the update is available.

Click Next to start the installation.

When the installation completes, launch the Deltek Cobra shortcut to log into Cobra and confirm
that the update is installed, meaning that users can now launch Cobra via Terminal
Services/Citrix sessions.

If You Have a Standalone Deployment

To install on the workstation:

1.
2.
3.

Verify that Cobra is not running.
Launch the update on the server.

The Welcome screen displays the current build, along with the new build being installed by the
update. Click Next to begin the installation.

The installation wizard installs all necessary files and displays the Update Complete form.
Click Finish.

Depending on the type of update, a reboot may be required. If the option to reboot your computer
is enabled, select it and click Finish.

Launch the Deltek Cobra shortcut to log into Cobra.

Confirm that the Cumulative Update is Installed

1.

o
r h

Click "==' » Help » About Deltek Cobra.
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2. Check that the version number reflects the installation of the update.

Cumulative Update 01 Release Notes 10



Deltek

Appendix B: For Additional Information

Appendix B: For Additional Information

Deltek Support Center

The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support
Plan (OSP).

The following are some of the many options that the Deltek Support Center provides:

Search for product documentation, such as release notes, install guides, technical information,
online help topics, and white papers

Ask questions, exchange ideas, and share knowledge with other Deltek customers through the

Deltek Support Center Community

Access Cloud-specific documents and forums

Download the latest versions of your Deltek products

Search Deltek’s knowledge base

Submit a support case and check on its progress

Transfer requested files to a Customer Care analyst

Subscribe to Deltek communications about your products and services
Receive alerts of new Deltek releases and hot fixes

Initiate a Chat to submit a question to a Customer Care analyst online

Attention: For more information regarding Deltek Support Center, refer to the online help available
from the Web site.

Access Deltek Support Center

To access the Deltek Support Center:

1.

Go to https://deltek.custhelp.com.

2. Enter your Deltek Support Center Username and Password.
3. Click Login.
Note: If you forget your username or password, you can click the Need Help? button on the login

screen for help.
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About Deltek

Better software means better projects. Deltek is the leading global provider of enterprise software and
information solutions for project-based businesses. More than 23,000 organizations and millions of users
in over 80 countries around the world rely on Deltek for superior levels of project intelligence,
management and collaboration. Our industry-focused expertise powers project success by helping firms
achieve performance that maximizes productivity and revenue. www.deltek.com
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